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Purpose
The Department of Veterans Affairs (VA) Documentation Style Guide provides a clear, concise, 
and easy to follow reference for writers and authors in the VA workspace to produce 
standardized artifacts based on industry standard best practices and VA documentation 
requirements.

This guide also creates continuity of look and feel (i.e., a uniform “branding”) for VA-required 
artifacts, enabling writers to focus on the quality of content development instead of how a 
document should be laid out on a page.

Within this guide, you can find guidance on the following:

· Basic styles
· Tables
· Graphics
· Links
· Grammar reminders
· Section 508 Guidelines

Should you have outstanding questions about VA documentation styles, contact the 
Documentation Style Guide Committee.

Responsibilities
All authors and writers must take the responsibility to ensure that documents comply with VA 
OIT Documentation Standards and follow this style guidance.
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Basic Styles
This section contains basic set of styles for: title page, headers, Body Text/Normal (regular and 
indented), lists, graphics, captions, tables, footer, inline text styles, or callouts.
NOTE: Set the default font color for all styles to black.

NOTE: Unless otherwise noted, all styles are singled-spaced.

NOTE:  In general, when creating or modifying styles, they should not be based upon other 
styles.
Table 1: Basic Page Settings

Type of Text Settings
Page Setup Margins: 1” for top, bottom, and sides.

Orientation: portrait; use landscape when needed.

Body Text or Normal Times New Roman, 11 or 12 pt., space before: 6 pt., space 
after: 6 pt.
NOTE: Calibri is also an acceptable alternative.
Body text must be left aligned, and font size must remain 
consistent throughout the document.

Tab Default tab stop: .5

Orphan/Widow Control On

Table 2: Title Page Settings
Type of Text Settings
Page Setup Separate section with vertical alignment centered on page 

(Page setup section, centered selected on vertical 
alignment)

Heading 1 (title) Arial, boldface, 18 pt., centered on line, single space, 0pt. 
before and 18pt. after

Title 2 (subordinate title) Arial, boldface, 14 pt., centered on line, single space, 0pt. 
before and 18pt. after

Graphic  
(e.g., VA Seal)

Centered on line, 48 pt. space before and after

Text below VA Seal Use Title 2 style
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Table 3: Basic Style Settings
Type of Text Settings
Heading 1 (Title Page) Arial, boldface, 18 pt., centered on line, single space, 0pt. 

before and 18pt. after

Heading 2 (Major Headings) New page, boldface, Arial 18 pt., space before: 0 pt., space 
after: 6 pt., Left aligned, not indented, 0.5” hanging indent, 
single spacing, keep with next, tab 0.5”

NOTE: If there are only a few sentences per Chapter, 
Heading 2 styles can be grouped on one page.

· Do not include Section or Page breaks.
· Add 12 pt. space before grouped Heading 2 styles.

Heading 3 Boldface, Arial 16 pt., space before: 6 pt., space after: 6 pt., 
Left aligned, not indented, 0.63” hanging indent, single 
spacing, keep with next, tab 0.63”

Heading 4 Boldface, Arial 14 pt., space before: 6 pt., space after: 6 pt., 
Left aligned, not indented, 0.75” hanging indent, single 
spacing, keep with next, tab 0.75”

Heading 5 and higher Boldface, Arial 12 pt., space before: 6 pt., space after: 6 pt., 
Left aligned, not indented, 0.75” hanging indent, single 
spacing, keep with next, tab 0.75”

Appendix 1 Use built in Heading 2 settings. Optionally, use built in 
Appendix 1 settings, if available.
New page, boldface, Arial 18 pt., space before: 0 pt., space 
after: 6 pt., Left aligned, not indented, 0.5” hanging indent, 
single spacing, keep with next, tab 0.5”

NOTE: If there are only a few sentences per Chapter, 
Appendix 1 styles can be grouped on one page.

· Do not include Section or Page breaks.
· Add 12 pt. space before Appendix 1.

Appendix 2 Use built in Heading 3 settings. Optionally, use built in 
Appendix 2 settings, if available.
Boldface, Arial 16 pt., space before: 6 pt., space after: 6 pt., 
Left aligned, not indented, 0.63” hanging indent, single 
spacing, keep with next, tab 0.63”

Caption Boldface, Arial 10 pt., space before: 6 pt., space after: 3 pt., 
positioned above tables and figures
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Type of Text Settings
Table of Contents 3 levels. Add more levels, if needed

· TOC1: Arial 14 pt.; boldface; left justified; hanging 
.38”; tabs: left .38” and right 6.49”; 3 pt. spacing 
before and after; paragraph formatting: keep with 
next and keep lines together

· TOC2: Arial 11 or 12 pt.; boldface; indented .25”; 
hanging .51”; tabs: left .75” and right 6.49”; 2 pt. 
spacing before and after

· TOC3: Arial 11 or 12 pt.; regular; indented .5”; 
hanging .63”; tabs: left 1.13” and right 6.49”; 2 pt. 
spacing before and after

· TOC4 and higher: Arial 11 or 12 pt.; regular; indented 
.n”; hanging .nn”; tabs: left .nn” and right 6.49”; 2 pt. 
spacing before and after. Author will need to set 
indents and left tab as appropriate for proper 
indentation and text wrapping

Table of Figures Arial 11 or 12 pt.; regular; no indent; hanging .31”; tabs: left 
.5 and right 6.49”; space before: 2 pt., space after: 2 pt.

Table Heading Boldface, Arial 10 or 11 pt., space before: 3 pt., space after: 
3 pt.

Table Text Arial 10 or 11 pt., space before: 2 or 3 pt., space after: 2 or 3 
pt., left justif ied, to be consistent throughout the entire 
document

Links Include screen tip text

Divider Pages (Legacy only) New page, boldface, Arial 24 pt., space before: 0 pt., space 
after: 6 pt., Left aligned, not indented. Use Title case.

Computer Screen Recreation 
(refers to character-based and 
not GUI-based screen 
captures)

Courier New or r_ansi. For example, in VistA screen 
captures, it is recommended that the font be no larger than 
10 pt.
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Type of Text Settings
Footers Built-in: Blank (Three Columns)

Times New Roman 10 pt.
· Left column:  

<Product Name> <Version Number> 
<Documentation Type>

· Center column:  
<Page Number> 
In front matter: roman numerals lower case, Different 
First Page (this removes footer from title page). In 
body, Arabic, Continue from Previous Section (this 
continues numbering from front matter using Arabic-
styled numbers).

· Right Column: 
<Month Year>

Prompts and Labels Use boldface formatting when referencing online prompts, 
labels, tabs, and dialogue/screen names in documentation 
for GUI-software (e.g., at the Patient Name prompt…).
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Visual Components

Tables
Create tables using the Insert Table tool within Word. 

· Do not allow text wrapping around the table (Text wrapping: None).
· Do not include title of a table within the table.
· Format table title using Caption style, placed above the table.
· Include column headings (Table Heading style) in the first row and mark it as a repeating 

header row.
· Use the Table Text style for the body of the table.
· Do not merge or split cells to avoid issues with screen readers.
· Show all grid lines.
· Add borders to all tables, 1 pt. black.
· Set left and right cell margins at .08”
· Align tables and table cells consistently (left, center, etc.) throughout the document.

Graphics
Insert graphics in line with text and place a caption above the graphic.

Group objects with the image and then flatten. Word allows an image to be marked up with any 
boxes, circles, or arrows needed to effectively highlight the important parts of the image, but 
those objects “float” on top of the image. This can break 508 guidelines. Flattening either means 
taking screenshots of the image with all its markup pieces and replacing all separate pieces with 
a single screenshot (this option limits editing the image in the future because there is no image 
source file) or exporting a grouped object from a photo editing program (e.g., PhotoShop, 
SnagIt) (allows the image to be updated because it creates an image source file that permits 
highlights to be manipulated in the future by ungrouping the image).

Add alternate text to all graphics. Following the graphic, provide a complete explanation of the 
contents of the graphic. 

Keep alternate text concise. The Section 508 group defines the character limit of the alternate 
text. Note any parts of an image that are called out or highlighted.

Consider the size of graphics (i.e., pixels) and how this can affect the libraries where an artifact 
will be housed. 

Best Practice: Refrain from using .bmp or .tiff files because they are not compressed. Instead, 
use the following to limit file size:

· .png
· .gif
· .jpg
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Keyboard Command Names
When referencing keyboard command names, format them in boldface type exactly as they 
appear on a standard keyboard and optionally enclose them in angle brackets. For example: 

· The “Enter” keyboard command would be shown as Enter or <Enter>. 
· The “Ctrl Alt Delete” keyboard command would be shown as Ctrl+Alt+Del or 

<Ctrl+Alt+Del>.
NOTE: Be consistent in format throughout the document.

Links

External Links
When linking to a web address (hyperlinks), include meaningful screen tip text, so users 
understand where the link leads.

Documents designed for publication external to the VA firewall must not contain links to VA 
Intranet pages (e.g., the software website).

NOTE: The Links section of the OIT Documentation Standards provides guidance on links to 
both external and internal publications.

Internal Navigation Links
Use Microsoft Word’s “Cross-reference” function to format references to figures, tables, 
chapters or sections, etc., within the same document.
Best Practice: Include the section name and not just the section number in the reference.

Grammar Reminders
Use active voice, whenever possible. Consider commonly misused words (e.g., "then" versus 
"than"), and common errors in capitalization and spelling.
Best Practice: Run the Spelling and Grammar check.
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Section 508 Guidelines
Authors must not use color as the only way to convey meaning; any important information 
denoted by color must also be available through text as well. Consider color blindness and 
unsighted user issues for color and contrast.

Do not embed files. Embedded files are not compliant because they are only accessible by 
mouse.

Add alternate text to graphics. The Section 508 group defines the character limit of the alternate 
text.

NOTE: Microsoft accessibility checkers tag tables without alternate text as errors; however, 
current guidance from the Section 508 group indicated this is no longer required and can be 
ignored.

According to direction from VA Section 508 eLearning Support, text less than 18 point, or less 
than 14 point if bolded, is to have a contrast ratio of 4.5:1 or more. Text 18 point or larger, or 14 
point if bolded, must have a contrast ratio must be 3.0:1 or higher.

Authors must ensure a considerable color difference between foreground and background text 
and images.

Best Practice: Make all text black on white to avoid contrast issues as a best practice.

Best Practice: Use a common metric like a numeral value or dif fering bar chart sizes (also pie 
charts). These universal metrics convey differences and magnitudes better than color.

Best Practice: Always run the MS Word Accessibility checker to eliminate errors. It is easier 
and faster to correct errors caught at the source level. 

NOTE: These guidelines do not cover all Section 508 rules and responsibilities; see the VA 
Section 508 links in the References section for more information.
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Tips and Tricks

Tables
Creating Tables
Use MS Word and properly configured table wizards to make tables. Do not use tables as a 
means to layout a page. Tables are Only for Tabular Data! It is important to restrict the use of 
tables only for presenting tabular data (spreadsheet-like information).

Screen readers (like JAWS) expect a table structure to contain spreadsheet-like information 
(tabular data) and can lock up when encountering tables inserted for page layout, column lists, 
and unnecessary Desktop Publishing Design effects.

1. Create table using Table selection in the Insert tab of the ribbon
2. Go to Table Tools
3. Right-click on Table Grid
4. Select Modify Table Style
5. Change default to 1 pt.
6. Set cell margins under Table Properties and then Options to 0.08”

Columns vs. Tables for Reading Order
Use columns in place of tables when reading order must be top to bottom, and then left to right. 

1. Create columns using the Columns selection in the Page Layout tab of the ribbon
2. Do not modify the spacing between columns (keep the default)

Images
Avoid using MS Word table features to create side-by-side columns to make sure that images 
stay adjacent to specific text. Using tables in this manner creates confusion for impaired users 
and screen readers.

White Space
When additional spacing is entered within sentences, paragraphs and words (such as excess 
carriage returns) it is read by screen readers and affects the normal flow of the document. Use 
paragraph spacing settings instead of carriage returns when additional line spacing is needed 
between paragraphs. Blank or special characters can be viewed by going to the Paragraph pane 
under the Home tab and selecting the Show/Hide button or using shortcut keys CTRL+SHIFT+*.

For signature blocks, the recommended spacing is 72 pt. before.
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Acronyms
Abbreviations and acronyms must be spelled out in the full text represented by the abbreviation 
or acronym followed by its abbreviation/acronym in parentheses the first time it appears in the 
text of each chapter of the manual or help topic. If the chapter is short (writer’s discretion), it is 
not necessary to spell out the acronym more than once. It does not matter how common the 
acronym or abbreviation is considered to be. For example: Department of Veterans Affairs (VA). 
Avoid defining acronyms and abbreviations in headings. Use a lower case “s” without an 
apostrophe to form the plural of an acronym (e.g., Information Security Officers [ISOs]).
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References and Related Links
VA Office of the Executive Secretariat Style Guide

VA OIT Documentation Standards

VA IT Strategic Communication (ITSC) Design Guide

VA Seal
VA Section 508 Office

VA Section 508 Office Accessibility Tools

Social Security Administration (SSA) Section 508 Accessibility Checklist for Word 2010
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Appendix

Section 508 Quick Reference Checklist
Use the following checklist as a tool to verify that all content meets VA established requirements 
for Section 508 conformance.

Document Layout and Formatting Requirements
· Have comments been removed and formatting marks been turned off?
· Has a full Accessibility Report been run on the document in Adobe Acrobat Professional 

10 or higher indicating that no errors are present? You may also use CommonLook 
Office to check and reconcile documents (and get a certificate).

· Have documents with multi-column text, tables, or call-out boxes been checked for 
correct reading order using the Acrobat Pro ‘Read Aloud’ function? (Only an option to 
see how readers work).

· Has a separate accessible version of the document been provided when there is no other 
way to make the content accessible? (Example: An organizational chart or a process 
flowchart).

· Does the document contain the correct Document Property Tags? Do the tags reflect the 
document structure?

o Headers: If a designation such as bold and / or italicized text is used to denote 
headings, have the headings been properly tagged?

o Lists: Are bulleted, numbered and / or alphabetical lists properly tagged?
o Links: Are links properly tagged with a <Link> tag, a Link-OBJR tag, and a 

content tag?
· Does the document have a logical reading order, i.e., is this tab order correct?
· Does the document have the language specified in the Document Properties? Language 

set correctly in all applications is important for Reviews and checkers.
· If the document contains a Table of Contents (TOC) or Bookmarks are they functioning 

correctly? If your document is well structured the TOC will build correctly. Also be sure 
to verify Capitalization in body and TOC.

· Do all URLs contain the correct hyperlink and display the fully qualified URL (i.e., http: 
/ / www.va.gov and not www.va.gov)?

· Are all URLs linked to the correct Web destinations? It is advisable to list a link only 
once in a document. The latest checkers also want you to provide a description for links.

· Personally Identifiable Information (PII) defined in OMB Memorandum M-07-1616 
cannot be included in VA artifacts. Users who submit documents for publication will be 
responsible for redaction of all PII prior to submission for publication.  Documents can 
be redacted by simply removing information or by writing over data with the word 
REDACTED.  
NOTE: Redaction standards apply to all text in a document to include screenshots, 
graphics and examples.
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Document Image Requirements
· Is the document absent of scanned images of text?
· Do complex images have descriptive text (alternative text) immediately after each image?
· Are multiple associated images on the same page (e.g., boxes in an organizational chart) 

grouped as one object? All multi-layered objects should be flattened into one image and 
add in Alternative Text (Alt Tag) for this image?

· Do decorative images that do not convey information have an empty Alternative Text 
(Alt Text) (i.e., alt=””)?

Document General Requirements
· Are all table cells, with the exception of those associated with the Header Row, 

designated as data cells? This is very important.
· Has a visual check been performed on the document to ensure that no hidden data from 

MS Word or any other source application (that was used for this publication) is present in 
the PDF file?

· Is the document file name concise, generally limited to a maximum of 30 characters? 
Make the content of the file clear in the context in which it is presented.

· Does the document contain scanned signatures? Embedding, converting, updating, and 
saving digital images can be complicated.

· Does the document use recommended fonts cited in the Documentation Style Guide and 
the VA OIT Documentation Standards, i.e., Times New Roman, Verdana, Arial, Tahoma, 
Calibri, and Helvetica?

· Do all data tables in the document have Row and Column headers?
· Are tables being used to create a layout and page structure (not tabs or spaces)? This is 

strictly prohibited. Some writers trained in DTP must refrain from this shortcut. Even 
artwork must now be in-line with text with no wrapping.

· Do all data tables in the document have a logical reading order from left to right, top to 
bottom?

· Are data cells in the tables logically associated with the Row / Column Header Elements?
· Are all data tables in the document named, numbered (if applicable) and have a 

description?
· Has a separate accessible version of the document been provided when there is no other 

way to make the content accessible? (Example: charts, graphs, processes, diagrams, 
multilayered tables, and organizational chart or complex processes). In this case consider 
telling the readers the same story as a table.
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